
Rapid ex vivo molecular fingerprinting of
biofluids using laser-assisted rapid evaporative
ionization mass spectrometry
Vera Plekhova1,5, Lieven Van Meulebroek1,2,5, Marilyn De Graeve 1, Alvaro Perdones-Montero3,
Margot De Spiegeleer 1, Ellen De Paepe1, Emma Van de Walle1, Zoltan Takats3,
Simon J. S. Cameron 4 and Lynn Vanhaecke 1,4✉

Of the many metabolites involved in any clinical condition, only a narrow range of biomarkers is currently being used in
the clinical setting. A key to personalized medicine would be to extend this range. Metabolic fingerprinting provides a
more comprehensive insight, but many methods used for metabolomics analysis are too complex and time-consuming to
be diagnostically useful. Here, a rapid evaporative ionization mass spectrometry (REIMS) system for direct ex vivo real-
time analysis of biofluids with minor sample pretreatment is detailed. The REIMS can be linked to various laser
wavelength systems (such as optical parametric oscillator or CO2 laser) and with automation for high-throughput
analysis. Laser-induced sample evaporation occurs within seconds through radiative heating with the plume guided to the
MS instrument. The presented procedure includes (i) laser setup with automation, (ii) analysis of biofluids (blood/urine/
stool/saliva/sputum/breast milk) and (iii) data analysis. We provide the optimal settings for biofluid analysis and quality
control, enabling sensitive, precise and robust analysis. Using the automated setup, 96 samples can be analyzed in
~35–40 min per ionization mode, with no intervention required. Metabolic fingerprints are made up of 2,000–4,000
features, for which relative quantification can be achieved at high repeatability when total ion current normalization is
applied. With saliva and feces as example matrices, >70% of features had a coefficient of variance ≤30%. However, to
achieve acceptable long-term reproducibility, additional normalizations by, e.g., LOESS are recommended, especially for
positive ionization.

Introduction

To date, metabolic fingerprinting of human biological fluids is most typically accomplished
through high-resolution mass spectrometry (HRMS) in hyphenation with a chromatographic
separation technique such as capillary electrophoresis, liquid or gas chromatography1,2. This analy-
tical approach allows for the sensitive and selective measurement of low-molecular metabolites
(<1,500 Da), generating a metabolic read-out that can be used to gain interesting insights into
biological and (patho)physiological processes3. More specifically, biomarker metabolites and biolo-
gical pathways can be shown to be associated with particular phenotypes of human health and
disease4. This approach does, however, have some substantial shortcomings that strongly restrict the
general application potential; i.e., protocols are often laborious and involving elaborate sample pre-
parations, which contribute to relatively low sample throughput rates and high costs as well as a
substantial risk for artifacts such as metabolite degradation, causing variable or poor recovery2.
These requirements and limitations mean that metabolic fingerprinting by hyphenated HRMS is not
practical for, e.g., point-of-care testing in clinical practice. Indeed, in that setting, there is a high need
for simplicity and automation to analyze large sample batches, there is only limited time for sample
analysis, the measurements are of an individualized nature and the physical sample size available is
often limited5,6.

It is therefore productive to explore alternative analytical strategies such as ambient ionization
mass spectrometry that are able to produce metabolic fingerprints, but that do not require extensive
sample preparation or chromatographic separation. With ambient ionization techniques, samples are

1Laboratory of Chemical Analysis, Ghent University, Merelbeke, Belgium. 2ProDigest BV, Zwijnaarde, Belgium. 3Department of Surgery and Cancer,
Imperial College London, London, UK. 4School of Biological Sciences, Institute for Global Food Security, Queen’s University Belfast, Belfast, Northern
Ireland, UK. 5These authors contributed equally: Vera Plekhova, Lieven Van Meulebroek. ✉e-mail: Lynn.Vanhaecke@UGent.be

NATURE PROTOCOLS |www.nature.com/nprot 1

PROTOCOL
https://doi.org/10.1038/s41596-021-00580-8

12
34

56
78

9
0
()
:,;

12
34
56
78
90
()
:,;

http://crossmark.crossref.org/dialog/?doi=10.1038/s41596-021-00580-8&domain=pdf
http://crossmark.crossref.org/dialog/?doi=10.1038/s41596-021-00580-8&domain=pdf
http://crossmark.crossref.org/dialog/?doi=10.1038/s41596-021-00580-8&domain=pdf
http://crossmark.crossref.org/dialog/?doi=10.1038/s41596-021-00580-8&domain=pdf
http://orcid.org/0000-0001-6916-401X
http://orcid.org/0000-0001-6916-401X
http://orcid.org/0000-0001-6916-401X
http://orcid.org/0000-0001-6916-401X
http://orcid.org/0000-0001-6916-401X
http://orcid.org/0000-0002-1088-7245
http://orcid.org/0000-0002-1088-7245
http://orcid.org/0000-0002-1088-7245
http://orcid.org/0000-0002-1088-7245
http://orcid.org/0000-0002-1088-7245
http://orcid.org/0000-0001-9570-135X
http://orcid.org/0000-0001-9570-135X
http://orcid.org/0000-0001-9570-135X
http://orcid.org/0000-0001-9570-135X
http://orcid.org/0000-0001-9570-135X
http://orcid.org/0000-0003-0400-2188
http://orcid.org/0000-0003-0400-2188
http://orcid.org/0000-0003-0400-2188
http://orcid.org/0000-0003-0400-2188
http://orcid.org/0000-0003-0400-2188
mailto:Lynn.Vanhaecke@UGent.be
www.nature.com/nprot
https://doi.org/10.1038/s41596-021-00580-8


analyzed in their native environment or after minimal pretreatment; and gas-phase ions are generated
under open-air conditions and directly introduced into the mass spectrometer5,7. Traditionally,
ambient ionization has been achieved through various desorption ionization methods such as
ambient pressure matrix-assisted laser desorption, direct analysis in real-time mass spectrometry,
desorption electrospray ionization, and secondary ionization mass spectrometry. These approaches
have been used successfully in the analysis of intact (ex vivo) biological tissues, but are not suitable for
ionizing living tissues. There, thermal evaporation techniques have become the norm, including
thermal electrosurgery and laser surgery8,9. These have mostly been used to determine the position of
the borders between malignant tumors and healthy tissue10.

Only recently, laser-assisted ambient ionization mass spectrometry (LA-REIMS, laser-assisted
rapid evaporative ionization MS) has also been exploited (by the authors of this paper) for rapid,
real-time fingerprinting of various human biofluids, i.e., saliva, urine, feces, sputum, breast
milk and plasma6,11,12. In this approach, the process of laser ablation is based on the laser-emitted
infrared wavelength regime that excites the most intense vibrational band (oxygen–hydrogen
stretching mode) of the water molecules that are highly present in the respective biological
fluids, initiating matrix-assisted desorption and ionization of intact biomolecules13. It should be noted
that, in comparison with other techniques, laser-assisted ionization does not require the usage of
solvents (versus, e.g., desorption electrospray ionization), high voltages or gas flows (e.g., direct
analysis in real time, 2–4 kV discharge needle voltage and 1.5–3.0 L/min gas flow rate), nor does it
require direct contact with the sample (e.g., hand-held sampling devices such as the iKnife that are
typically used to cut through tissue and rapidly heat it, to generate a vapor)6. The approach that is
used in this protocol is very similar to the iKnife, but the fact that there is no probe that has
direct contact with the samples means that the cleaning requirements and the risk of sample-to-
sample contamination are substantially lower. These are considered essential conditions for
platform automation.

In LA-REIMS, no pretreatment is needed for the analysis of fresh feces, urine, plasma, breast milk
and sputum, and only centrifugation and filtration are required for saliva analysis. As such, finger-
printing of biofluids by LA-REIMS could generally be achieved within <1 min per sample6,11,12. In
addition, we assume that artifactual metabolite modifications are less likely to occur in experiments
with fewer sample processing steps and shorter analytical times. In comparison with hyphenated
techniques, LA-REIMS has substantially fewer analytical biases relating to sample pretreatment,
extraction and storage (i.e., samples are analyzed in or very close to their native condition), or
resulting from chromatographic and mass spectrometric drifts (i.e., the analysis times are
much shorter).

Without chromatographic separation, however, metabolome coverage is likely to be lower as
characterization of metabolite-associated features is based on mass measurements only. As such, it
will, for example, not be possible to separate isomers and isobars. This also limits the possibilities for
quantification. Data from LA-REIMS are thus not as comprehensive as those from conventional
metabolic fingerprinting approaches (i.e., ultra-high-performance liquid chromatography-high-
resolution mass spectrometry (UHPLC-HRMS))12. In addition, secondary ionization of ablated
metabolites at the rapid evaporative ionization (REI) collision surface may also suffer from ion
suppression, which has adverse effects on sensitivity and quantification accuracy14. As such, biofluid
metabolomics by LA-REIMS may primarily find acceptance in first-line segregation of samples based
on distinctive fingerprints and according to (patho)physiological state, as has been demonstrated by a
number of clinical studies6,11,12. For a more detailed read-out of the metabolome, conventional
hyphenated techniques can be used to achieve advanced separation and in-depth characterization as
well as quantification of metabolites.

Laser ablation ambient ionization mass spectrometry has also been described for rapid
metabolic fingerprinting of tissue (e.g., by Fatou et al.13 and is the subject of another Nature Protocol
(i.e., Ogrinc et al.7. This manuscript, therefore, focuses on rapid metabolic fingerprinting of biofluids
and captures the experience gained in multiple studies published by the involved authors. Key
procedural differences are found at many stages of the protocol: at the level of the instrumental setup
(e.g., the need for a T-shaped connector piece at the REI source to concentrate the low metabolite
concentrations as present in the aerosol), instrumental settings (both with respect to the laser as well
as the REI mass spectrometer) as well as biofluid sample handlings (e.g., specific volumes,
pretreatments and cleaning procedures). This work also describes how to adapt the method
for automation.
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Ex vivo direct biofluid molecular fingerprinting using LA-REIMS
The LA-REIMS methodology (Fig. 1) starts with the direct ablation and aerosolization of the sample
surface by laser irradiation. In this protocol, an Nd:YAG laser (operating wavelength of 2.94 μm) and
CO2 laser (operating wavelength of 10.64 μm) for laser irradiation are described. A detailed com-
parison between these laser types can be found in the study by Schäfer et al.15 that reported on the
reproducibility of analysis, induction of photochemical processes, coagulative properties, and uni-
formity of the generated mass spectra according to wavelength, specifically assessed for tissue. For
biofluid analysis, own research indicated the suitability of both laser types to achieve comprehensive
metabolic fingerprinting, however, without having made explicit comparisons. The energy of the
emitted infrared laser beam is absorbed by the water molecules, abundantly present in the biological
matrices, as a result of the stretching vibrations of the hydroxyl groups16. This desorption and
ionization mechanism has the unique advantage of being able to exploit the presence of abundant
endogenous water17,18.

The setup also features an MS source (i.e., REI source) that is specifically designed to efficiently draw
the produced aerosol through an aerosol vent transmission tube (millisecond timescale) into the deep
vacuum region of the MS instrumentation. This tube interfaces the MS source by means of an ortho-
gonally mounted T-shaped connector piece and designated insert that is surrounding the aerosol inlet
tube. In the source, declustering of the aerosol, comprising desorbed droplets of both positive and negative
analyte ions, takes place by collision onto a heated impactor, whereby individual molecular species are
generated. Therefore, LA-REIMS is a two-step technique involving desorptive release of the chemical
components and secondary ionization mechanisms17. Ionization is assisted by a solvent matrix, for
example, isopropylalcohol, that is provided at the REI source19. This solvent plays a role similar to that in
matrix-assisted laser desorption ionization (MALDI) in that it reduces intermolecular forces and improves
ion formation20. More specifically, the polar protic nature of isopropylalcohol is useful in dissolving lipid
species and, as such, enables the formation of individual molecular ions via a collision driven ion release
mechanism (heated impactor) that ultimately enhances the signal-to-noise ratio21. Moreover, aerosol
dilution reduces fouling at the inlet capillary, resulting in better spectral classifications and allowing the
instrument to run under high-throughput conditions. The flow rate of the solvent matrix is optimized for
every biological matrix type (e.g., 150 µL/min for feces) and can contain a ‘lock mass’ external calibration
compound (e.g., 10 ng/mL leucine-enkephalin).

As a measure of securing consistency in the analysis process through reduction of operator-related
factors and to further increase the analysis speed, an automated versatile multiwell plate-based
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Fig. 1 | A schematic representation of the LA-REIMS workflow. Technical scheme of the LA-REIMS setup whereby a laser beam is focused onto a
sample, being placed on either an automated stage equipped to handle 96-well plates or a microscope slide for single samples. Rapid heating and
evaporation takes place, and the resulting analyte-containing aerosol is aspirated towards the mass spectrometer under the instrument’s internal
vacuum. The vapor is mixed with a solvent matrix containing lock mass/external standards and collides with a heated collision surface to form
gas-phase ions for analysis. Ions are analyzed using a QToF-MS, and the resulting mass spectra are used in multivariate and machine learning
classification models.
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Fig. 2 | A flowchart of a standard LA-REIMS biofluid analysis experiment. Summary of steps involved in the implementation of LA-REIMS for
molecular fingerprinting of biofluids, with time indications per step.
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platform was incorporated in the standard REIMS workflow. The latter serves to introduce fully
remote and automated fingerprinting of a large number (up to 576) of small volumes of biological
material in a fraction of time. Additionally, as positioning the samples inside the restricted area of
each well results in a more uniform sample distribution compared with the open area of the
microscope slide, the microplate configuration contributes further benefits to standardization of
analyses. A flowchart (Fig. 2) presenting the entire procedure from sample collection to data pro-
cessing is provided.

Applications of the method
Whereas blood is the most sampled biofluid in clinical research22, diverse alternatives are available
that can be accessed noninvasively and offer an at least equally rich and chemically diverse meta-
bolome coverage, reflective of various biological processes. Among those are urine (a key harbor of
metabolic waste products10 addressed in, e.g., illicit drug screening), saliva (parallels metabolic
alterations occurring in blood and applied in studying, e.g., obesity12), stool (ideally suited to study
the diet–microbiome–metabolome axis in gastrointestinal disorders, e.g., type 2 diabetes23) and
sputum (a means to study bacterial activity within the airways, e.g., in cystic fibrosis24). LA-REIMS
provides an almost instantaneous fingerprinting strategy without (or hardly) damaging the analyzed
biofluids and, as such, allows for cross-evaluation with conventional methodologies. In this regard,
the LA-REIMS platform described presently has recently demonstrated rapid fingerprinting of saliva
and feces, each complemented by metabolic profiling and cross-evaluation against established
UHPLC-HRMS metabolomics and lipidomics platforms23,25 for in-depth biological interpretation.
The ambient ex vivo analysis of both cited biofluids allowed the establishment of validated multi-
variate models that were predictive for assigning metabolic perturbations according to pathophy-
siology, i.e., weight and glycemic state, and provided general classification accuracies of 97.1% and
90.5%, respectively12. Thus, LA-REIMS represents an expedient strategy in first-line distinctive
metabotyping based on easy-to-obtain biofluids11.

Limitations and potential improvements of the protocol
The LA-REIMS method presented here suffers similar limitations as many other methods in the field
of ambient ionization mass spectrometry and wider fields of direct and flow infusion MS26. These
limitations arise from the removal of chromatographic separation of the chemical contents of a
sample, prior to ionization. For LA-REIMS, this means that ion formation for a sample’s metabolic
fingerprint is condensed into a 2–8 s time frame compared with hyphenated methods, such as liquid
chromatography (LC)- and gas chromatography (GC)-MS, where molecules are introduced for ion
generation over a typical 10–20 min period6. Due to ion suppression effects, this will likely result in a
lower sensitivity of the LA-REIMS method compared with hyphenated methods, even when the same
high-resolution mass spectrometer is used for analysis. The use of internal or external standards may
provide a relevant strategy to address this issue, although it is not possible to reach sufficient
representativeness for all metabolome constituents. In addition, the lack of chromatographic
separation also hampers the structural identification of features. Indeed, without having retention
time as an orthogonal separator, it is not straightforward to cluster different m/z features that are
originating from the same metabolite (e.g., [M + H+] and [M − H2O + H+] ionization adducts) nor
is it possible to distinguish metabolites that are represented by identical or similar m/z values (i.e.,
isobars or structural and stereoisomers)27. This can be somewhat overcome by using the instrument’s
tandem MS functionality and by consulting repositories with fragmentation data. However, inter-
pretation of fragmentation data is not evident as metabolites with identical or similar m/z values will
be subjected to the the same selection and fragmentation event, resulting in intertwined fragmen-
tation m/z spectra. Moreover, the inclusion of fragmentation scan events during the short period of
the burn is at the expense of the full-scan events, which may have adverse consequence for the
sensitivity and quantification accuracy. Hence, the information that is obtained from chromato-
graphic separation and that is supportive for identification cannot be easily replaced. One strategy to
improve the analytical resolution of LA-REIMS, being equivalent to chromatographic separation,
could be the application of ion mobility separation28. As separation occurs on the millisecond scale, it
complements the method’s rapid analysis time and provides a second dimension to analytical
resolution. Moreover, it is does not interfere with the full-scan events. The use of ion mobility would,
however, add extra complexity to instrumental operation and maintenance, which does not fully align
with the purpose of LA-REIMS to translate metabolomics into clinical practice and for point-of-care
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implementations. In this respect, as earlier noted, LA-REIMS is merely proposed as a strategy for
first-line seggragation of samples, without in-depth biological-mechanistic explorations.

Further benefits to the LA-REIMS method could be achieved through alternative means of sample
heating and evaporation, particularly with regard to the pulsatile and wavelength characteristics of

Box 1 | Sample preparation ● Timing 0–15 min

This box describes sample handling and preparation for analysis of freshly collected as well as previously frozen samples.
! CAUTION When using human samples in experimental settings, all necessary local and global ethical regulations should be fulfilled.

Additional materials
● Plastic microcentrifuge tubes, 2 mL (Eppendorf, cat. no. 0030120094)
● Microcentrifuge, MicroCL 17 (Thermo Fisher Scientific, cat. no. 75002406)
● Analytical balance, ML104T/00 (Mettler Toledo, cat. no. 30243394)
● 1 mL Luer slip syringes (Becton Dickinson, cat. no. 303172)
● Polyamide membrane filters, CHROMAFIL, 13 mm diameter, 0.45 μm pore size (Macherey-Nagel, cat. no. 91652)
● Sartorius Arium 661 UV water purification system (Sartorius, cat. no. H2OPRO-UV-B-TOC)
● Vortex shaker IKA vortex genius 3 (IKA-Werke, cat. no. 0003340000)

Procedure

c CRITICAL STEP All frozen samples should be defrosted at 4 °C shortly before described pretreatment procedures.

Saliva
1 Vortex raw samples (freshly collected or defrosted) for 30 s at 400g and room temperature (25 °C) to ensure homogenization.
2 Transfer 450 µL of each sample into separate microcentrifuge tubes.
3 Centrifuge at 17,000g for 5 min at room temperature.
4 Collect all resulting supernatant in 1 mL syringe, and pass through polyamide membrane filter into new microcentrifuge tube. This can be

analyzed immediately or stored at −80 °C, preferably for <1 month43.

Feces
1 Freshly collected stool samples can be homogenized manually with a sterile spatula or using commercially available homogenizers (e.g.,
Stomacher) according to manufacturer guidelines. Following homogenization, these samples are ready for LA-REIMS analysis.

2 If prolonged storage of fecal samples is required, consider lyophilizing the samples. They can then be stored at −80 °C, preferably for
<2 months29.

3 When preparing the lyophilized samples for LA-REIMS analysis:
(i) Weigh 200 (± 1) mg of lyophilized homogenized feces in 1.5 mL microcentrifuge tube.
(ii) Add 600 μL of ultrapure water.
(iii) Thoroughly mix by vortexing for 60 s at 400g (if homogeneity is not achieved, additionally a sterile spatula may be used), and keep at

4 °C prior to analysis.

Urine and blood plasma
1 Freshly collected samples do not require any pretreatment. If analysis is not performed immediately, samples can be stored at −80 °C for
preferably <1 month30,44.

2 Defrosted samples require a homogenization step, by vortexing at 400g for 30 s, and keep them at 4 °C prior to analysis.

Human milk
1 Homogenize freshly collected samples by vortexing at 400g for 30 s. These can be analyzed directly or frozen for storage at −80 °C for
preferably <3 months45.

Vortex after defrosting at 400g for 30 s, and keep at 4 °C prior to analysis.
2 If the analytical focus is fat and complex lipids, perform refrigerated centrifugation (4 °C) for 5 min at 3,000g to create a fat layer that can be

directly analyzed by LA-REIMS. If required, the fatty layer can be removed from the aqueous phase with a sterile single-use 10 μL
microbiological inoculating loop and transferred to a sterile microcentrifuge tube for separate analysis.

Sputum
Freshly collected samples do not require any pretreatment. If analysis is not performed immediately, frozen samples can be stored at −80 °C for at
least 1 month24. Defrost at 4 °C prior to LA-REIMS analysis.
If desired for easier homogenization of the sample matrix, sputum can be treated with Sputasol (#SR0233, Oxoid, Thermo Fisher Scientific)
following standard manufacturer’s instructions. This can be completed on freshly collected samples prior to analysis or prior to storage at −80 °C.
Homogenization may be necessary where visible color heterogeneity exists within the sample or variations in consistency across the sample is
noted, and which is not resolved through vortex mixing. During experimental design, consideration should be given to whether sample
homogenization with Sputasol should be undertaken regardless of sample appearance as it would be a likely source of bias to only treat a selection
of samples.

QC samples
1 Define how many analytical runs will be considered for the LA-REIMS experiment, and calculate how many QC runs are needed. Guidelines
regarding the number and frequency of eQC and iQC samples have been defined previously (see ‘QC samples’).

2 For determination of the total volume needed, take into account the recommended starting volumes per matrix type (see the Procedure), and
consider a separate glass microscope slide/well for every QC run.

3 Establish a QC pool by taking equal aliquots from (a selection of) representative samples or by considering general reference material. Vortex
the QC pool thoroughly.

4 Store the QC-pool at −80 °C if LA-REIMS analysis is performed, either continuously or discontinuously, for several days. Consider preparing
aliquots of the QC pool for storage, to avoid freeze–thaw cycle effects.
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lasers. It may be possible to target specific chemical classes through optimization of laser choice,
reducing ionization competition and improving analytical sensitivity. Similar benefits could be
pursued through modification of the solvent matrix including different polarities, or through the
addition of additives to enhance the ionization of particular analytical targets21.

Experimental design
Sample preparation
The method allows for the analysis of freshly collected as well as thawed specimens (Box 1). If
samples cannot be analyzed immediately upon collection, storage at −80 °C is recommended to
preserve the metabolic fingerprint. Aside from temperature conditions, maximal storage duration
should be considered when designing the experiment as well29,30. Liquid samples can be prepared into
aliquots and frozen without treatment, while semi-solid matrices (such as feces) should preferentially
undergo lyophilization31 prior to storage.

QC samples
In addition to samples under investigation, external quality control (eQC) samples should be pre-
pared for instrument conditioning and internal quality control (iQC) samples for monitoring
instrumental performance and possible data normalization. For cohort studies, these QC samples can
be prepared by dividing into aliquots and thoroughly mixing equal volumes from a selection of
representative samples (e.g., including the assessed disease states, age categories or treatments) or,
preferably, from all biological samples. The final volume of the QC blend should allow to include ten
eQCs per ionization mode at the beginning of the sequence and two iQCs every 20–40 analytical runs
(depending on batch size and available sample volume)11. On the other hand, a reference material
that is not directly derived from the sample batch for analysis can be used as well, being self-
assembled from any excess experimental samples or commercially available (e.g., pooled human
serum, MP Biomedicals, cat. no. 2930149). This may be particularly useful for discontinuous LA-
REIMS analysis of samples across several analytical batches, e.g., for general metabotyping or specific
diagnosis of patients.

LA-REIMS system setup
We have used two types of laser in our work: the mid-infrared (MID-IR) laser and the CO2 laser.

MID-IR laser
The installation used comprises a MID infrared laser system (Opolette HE2940, OPOTEK) consisting
of a Q-switched Nd:YAG laser pumping optical parametric oscillator (OPO). The system output is
fixed at 2.94 μm wavelength, 6 mJ peak OPO energy, 7 ns pulse duration and 20 Hz repetition rate.
Q-switch delay time is a tunable parameter with a direct impact on the transferred laser energy. The
delay time may be optimized for each biofluid matrix separately depending on the produced peak
intensity and repeatability, ranging between 165 and 180 μs (see ‘Equipment setup’). The OPO beam
transmission and focusing on the sampling area is achieved by the free space steering optics con-
sisting of three metallic-coated mirrors and a plano-convex lens placed directly above the sampling
surface. The sampling area position 5.5 cm below the focusing lens as well as the laser focusing optics
represent a fixed construction and, once set and aligned, do not require routine tuning before each
experiment. Laser beam and external optics alignment verification, however, have to be performed on
any new installation and systematically checked (Box 2).

CO2 laser
This is typically a modified surgical CO2 laser, operated at a 10.6 µm wavelength. Previous pub-
lications have utilized an OmniGuide FELS-25A (OmniGuide) or Aesculight VetScalpal (Aesculight)
using either mirror optics or a hollow-core fiber for laser beam transmission. A single mirror focusing
handpiece is used to direct the beam to a spot size of ~500 µm. These surgical CO2 lasers are used as
they have been created for the cutting and cauterizing of animal tissue, and their wavelength and
absorbance profiles are thus complementary to the analysis of biological materials. They are typically
at the lower end of CO2 laser powers (<10 W) that are commercially available, particularly when
compared with industrial CO2 lasers (>100 W) used for cutting/engraving applications. Optimization
of CO2 laser power and delivery can be carried out for different biological materials by altering the
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power output, pulsatile window and distance between focusing lens and sample. The output of the
CO2 laser should be periodically checked with an appropriate power monitor (such as Pronto-250-
PLUS, Gentec Electro Optics) to ensure output is within the expected range.

LA-REIMS sample analysis
As a measure to ensure accurate laser energy transmission to the sample, it is essential to establish the
correct position of the laser optics and/or sampling area prior to analysis in such a way that the laser
focus point lies within the surface or the top layer of the specimen. Besides, as the laser focusing lens
is positioned merely 5 cm above the sampling surface and, hence, prone to contamination resulting
from the ablation process, it is important to monitor and ensure its cleanliness during the analytical
runs. In particular, the state of the lens should be evaluated every five to ten ablations12, depending on
the sample type. When contaminated, the lens should be cleaned with a cotton swab drenched in
ethanol. Interestingly, positioning samples in a microtiter plate (automated sampling, see below)
instead of on glass microscope slides (manual sampling, see below) reduces the distribution of liquid
splashes during ablation and the resulting focusing lens contamination and, hence, the frequency of
cleaning. In the case of automated sampling using microtiter plates, prominent focusing lens con-
tamination and associated decrease in MS signal intensity (of more than one order) has been observed
only after 30–50 ablations (depending on the matrix type under study). Nevertheless, we recommend
lens cleaning to be performed at least every 5 ablations during manual sampling and every
12 ablations during automated sampling to anticipate any possible signal issues (Step 30 of
the Procedure).

Box 2 | MID-IR laser alignment verification procedures ● Timing 20–30 min

This box describes laser alignment and routine alignment verification for the MID-IR OPO laser. Alignment of the CO2 laser follows a similar principle.
! CAUTION Always wear eye protection with sufficient optical density while operating the laser. Consult class 4 laser safety measures and
equipment manual for additional precautions while operating the installation.

Additional equipment
MIR detector cards: 1.5 to >13.2 µm (Thorlabs, cat. no. VRC6S)
Optical alignment target (shipped with Opolette HE2940 MID-IR laser system)

Procedure
Laser alignment verification

c CRITICAL Beam alignment has to be performed on a new installation and assessed periodically following manufacturer recommendations or
whenever laser misalignment is suspected (e.g., you have moved the setup).
1 On the front panel of the Opolette laser head, expose the laser pump port by moving the shutter marked ‘1064’ to the side.
2 Screw the optical alignment target to the port with the uncovered area up (thus allowing visualization of the alignment target interior).
3 Set Q-switch delay time to 320 μs in the Q-switch configuration menu within laser control software or on handheld remote controller panel.
4 Activate the laser beam by consecutively pressing the ‘Start’ buttons on the flash lamp and Q-switch sections of the remote control/control

software. The green light should appear around the alignment target aperture.
5 Check the position of the green light beam on the alignment target aperture. If the beam is centered, the laser is aligned and can be safely

operated. Otherwise contact OPOTEK support center.
6 Press the ‘Stop’ button subsequently on the flash lamp and Q-switch sections of the remote control/control software to deactivate the laser.

! CAUTION Do not decrease Q-switch delay time below 300 μs while aligning as it may damage the alignment verification target.
! CAUTION Do not further operate the system if the laser is misaligned or if the correct alignment cannot be verified.

External optics alignment verification

c CRITICAL Correct alignment of the laser steering optics is required for sufficient energy transmission and is crucial for operator safety.
? TROUBLESHOOTING
7 To activate the alignment diode, toggle the switch at the back of the laser pump case. The red light will become visible as projected on the

sampling surface guided by the set of metallic-coated mirrors.
8 Check the projected position of the diode light on the working surface: the beam should pass through the middle of the focusing plano-convex

lens. If not, adjust the positions of the metallic-coated mirrors.
9 Set the laser system in the operation mode as described in Step 2 of the Procedure.
10 Place the thermosensitive MIR detector card underneath the focusing lens so that the projected alignment diode light is visible on the card’s

surface.
11 Activate the laser beam by pressing the ‘Start’ button subsequently on the flash lamp and Q-switch sections of the remote control/control

software.
12 The area of the discoloration on the MIR detector card will indicate the projection of the laser beam, and that position should overlap with the

alignment diode projection.
13 Deactivate the laser by consecutively pressing the ‘Stop’ buttons on the Q-switch and flash lamp sections of the remote control/control

software.
14 Toggle the switch at the back of the laser pump case to deactivate the alignment diode.
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For the manual analysis, 20–50 μL of the liquid biofluid (or thin layer of fecal blend) is
pipetted on a glass microscope slide. Next, the slide is manually transferred under the laser
beam focusing point and irradiated for 3 s and removed. In between sample ablation, the solvent
signal is recorded for 3–4 s to ensure that the signal intensity drops to the background level and
guarantee good peak resolution (Fig. 3). The method acquisition time is set to 30 s per sample, which
is sufficient to generate two to three technical replicates (ablations) within one acquisition period,
if desired11.

The automated sampling platform employs a simple in-house made two-axis (XY) motorized
precision position stage (Fig. 4a) that can hold up to six different 96-well plates on the mobile
platform. The customized controlling software defines the platform movements and laser activation/
deactivation sequence. The moving stage subsequently positions the samples in the separate wells
under the laser focusing point. Every irradiation (ablation) is followed by a cooldown period during
which the next well is positioned below the laser focusing point and a new acquisition datafile is
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Fig. 3 | Typical burns for LA-REIMS analysis. a,b, LA-REIMS burns as acquired for a stool sample in negative (a) and
positive (b) ionization mode, with an MS scan time of 0.3 s per scan and (automated) laser ablation time of 3 s.
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Fig. 4 | Close-up of the motorized automated sampling area and its connection to the REIMS source.
a, Configuration of the motorized stage, with the laser beam focused on the surface of the stage and the sample tube
positioned above the laser focus point. b, Picture of the connection of the sample tube through the stainless-steel
T-shaped connector piece with the solvent line and the inlet of the REIMS source.

NATURE PROTOCOLS PROTOCOL

NATURE PROTOCOLS |www.nature.com/nprot 9

www.nature.com/nprot


initiated by the recording software. The sample volume within each well is recommended to be at
least 50 and up to 100 μL as bigger volumes are better preserved during prolonged exposure of the
liquid samples to ambient conditions during automated analysis as opposed to manual sampling.
Although the recommended sample volume is substantially higher when using automated sampling
compared with manual sampling, the (semi-)liquid within the well plates can be subjected to repeated
laser ablations without loss of signal intensity or spectrum quality (see ‘Precision’ under ‘Anticipated
results’ for more detail). An additional measure that can be taken to minimize passive evaporation of
the specimens within the wells during analysis is the installation of a local thermoelectric (Peltier)
cooling element in the sampling area to create an optimal (cooled) microenvironment.

Daily calibrations of the MS instrument during active sample analysis periods should be per-
formed according to manufacturer guidelines to ensure the highest mass accuracy (e.g., sodium
formate solution in 90:10 isopropylalcohol:water (vol/vol) for calibration of Waters QToF/Q-IMS-
ToF instruments)6,11. Moreover, when starting the instrument after cleaning or planning sample
analysis for different matrices, it is advised to run 10–20 pooled eQC samples in both ion modes to
secure adequate instrument conditioning before starting the analysis or switching to another matrix
type11. This measure reduces initial signal drift within the samples of interest during the actual
experiment. A representative number of iQC samples (two between every 20–40 analytical runs)
should be analyzed to monitor and compensate for possible MS signal output changes during the
analytical run (analytical drift). A final strategy to ensure the quality of collected data is the usage of
external standards infused together with the solvent matrix (e.g., leucine-enkephalin6 or a combi-
nation of palmitic acid-d31 and 1,2-dimyristoy-d54-sn-glycero-3-phosphocholine

11). This allows for
evaluation of instrument analytical performance as well as lock mass correction and data
normalization.

LA-REIMS data collection
Data collection is performed using MS vendor-specific software. All MS methods for automated
programs are set at 18 s per sample acquisition time, while 30 s is used upon manual sampling12.
Mass spectra can be collected as one raw data file per sample, which may reduce downstream data
processing but increase time for data collection. Alternatively, one raw data file per microwell plate or
batch could be generated, which may then decrease time for data collection as a result of reduced
instrument electronic control but requires the splitting of files and thus increases subsequent
downstream data processing.

Data analysis and classification modeling
Data analysis can be performed using any kind of software that runs the appropriate sort of algo-
rithms. Box 3 describes the procedures that were followed, using the software that was available to the
authors of this protocol.

During LA-REIMS analysis, molecular fingerprints are acquired by MS vendor-specific software,
such as MassLynx (v4.2, Waters, stored as .raw directories) in the case of Waters instruments. Prior to
performing classification modeling, several preprocessing steps are implemented to select repre-
sentative burns, subtract background and noise, and perform peak picking (steps 1–12 in Box 3). In
general, these preprocessing steps are also executed using vendor-specific software (Progenesis Bridge,
Progenesis QI, AMX or Live ID, Waters). Alternatively, spectra can be preprocessed using freely
available open-source metabolomics software such as XCMS32 and MZmine33.

Following preprocessing, peak lists of m/z features are subjected to multivariate statistical analysis,
typically including principal component analysis (PCA34) and orthogonal partial least squares dis-
criminant analysis (OPLS-DA35) (using software packages such as SIMCA (v15, Sartorius)) (steps
13–22 in Box 3). PCA serves as an unsupervised dimension reduction technique to investigate
variance within the dataset. OPLS-DA is a supervised regression methodology whereby user-defined
groups are taken into account, thereby pursuing classification of the groups based on discriminative
features. The (validated) models can be utilized to extract discriminative features that can further
undergo identification using fragmentation experiments and database matching.

In Box 3, data analysis and classification modeling from raw files collected on the LA-REIMS
instrument (Waters) is described by the sequential use of Progenesis Bridge (v1.0.29, Waters),
Progenesis QI (v2.1, Waters) and SIMCA (v15, Sartorius) software.
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Box 3 | LA-REIMS data analysis and classification modeling ● Timing 1 h for ~500 samples

This box describes the preprocessing and classification modeling (Steps 31–34 of the Procedure) that is performed after data acquisition by
LA-REIMS. This biostatistical pipeline can be used for any type of analyte described in this protocol, and uses three commercially available
software packages.
The first program, Progenesis Bridge (v1.0.29, Waters), is capable of handling Waters MS .raw directories and performs background subtraction
and lock mass correction (optional), creates extracted ion chromatograms for each burn and separates multiple burns in each raw folder into
individual raw folders. This separation enables individual burns to be treated as individual samples. For further treatment in Progenesis QI, all
individual peak raw folders can be loaded or one peak per sample can be selected. In case of the latter, it is suggested to use the peak with the
highest total ion current (TIC) value. TIC can be assessed by manually inspecting each chromatogram in MassLynx (Waters).
Next, the raw data are ready for importing into the second software program, Progenesis QI (v2.1, Waters), where peak picking and TIC
normalization is performed and lists of m/z features are generated. In a third software program, SIMCA (v15, Sartorius), fingerprints can be
visualized, quantified and statistically classified, and discriminating features can be defined. The data analysis pipeline consists of the steps
summed below.

Procedure
1 Open Progenesis Bridge, fill in fields a–d, as described below, and click ‘Run’.

a Source: directory path containing nonprocessed Waters .raw directories.
b Output path: directory path where processed data will be stored.
c TIC replicate threshold: threshold between background and peak intensity. Should be set at approximately one-third of peak height.

? TROUBLESHOOTING
d Lock mass correction: none.

2 Open Progenesis QI, click ‘File’ > ‘New’ and fill in experiment name and directory path.
3 Set the analysis parameters of new experiment a to c, as described below, and click ‘Next’.

a Type of machine: direct sample analysis.
b Data format: profile data.
c Ionization polarity: select correct polarity according to the experiment.

4 Select the possible adducts according to the experiment, and click ‘Create experiment’.
5 In the created experiment window, in tab ‘Import Data’, choose Waters (.raw) format and click ‘Import’ to select and import files that need to be

processed.
6 In the created experiment window, in tab ‘Import Data’, click ‘Start automatic processing’.

a Experimental design can be left empty at this stage; click ‘Next’.
b Set the peak picking parameters by clicking ‘Set parameters’, fill in and click ‘OK’.

(i) Peak picking limits > Sensitivity: Automatic – default.
(ii) For the other parameters, default values should be attained.

7 In the created experiment window, in tab ‘Experimental Design Setup’, click ‘Between-subject Design’, fill in and click ‘Create design’.
a Design: new design.
b Group runs manually.
c Create design.

8 In the created experiment window, in tab ‘Experimental Design Setup’, select all samples, and click ‘Add Selected Runs to Condition’.
9 In the created experiment window, in tab ‘Peak Picking’, click ‘Review Normalisation’, click ‘Normalisation Method’ and select ‘Normalize using

total ion abundance’.
10 In the created experiment window, in tab ‘Review Compounds’, check information of compounds.
11 Click ‘File’ > ‘Export compounds measurements’, select information to export and click ‘OK’.

a Select Compound, m/z, normalized abundance, raw abundance.
12 Transpose, rearrange and add classification labels prior to loading peak lists into SIMCA. Optionally, (internal) QC normalization can be

performed during this step.
13 Open SIMCA, click ‘File’ > ‘New’ > ‘Regular Project’.
14 Paste the data from the .csv file into the ‘SIMCA Import’ window.
15 Create workset by defining the data, and click ‘Finish import’.

a Define the row head as ‘Primary ID’.
b Define the column head as ‘Primary ID’.
c Define the second column head to select a data type ‘Y variable with Qualitative Data’ or ‘Y with Quantitative Data’, depending on the

experiment type.
? TROUBLESHOOTING

16 In the ‘Home’ tab, click ‘Change model type’ > ‘PCA-X model’.
17 In the ‘Home’ tab, click ‘Edit’ to control the PCA settings, and click ‘OK’.

a Click tab ‘Scale’, select all and choose type, e.g., Par (Pareto scaling).
b Click tab ‘Transform’, select all, choose ‘Specify transformation’: Log, click ‘Set’, select box ‘If one variable in the X or Y block needs

transformation, transform all selected variables in that block’ and click ‘Transform’.
18 In the ‘Home’ tab, click ‘Autofit’ and ‘Scores’ to visualize model.
19 In the ‘Home’ tab, click ‘New as’ > ‘PCA-X’ (copy settings previous model), and click ‘OK’.
20 In the ‘Home’ tab, click ‘Change model type’ > ‘OPLS-DA model’.
21 In the ‘Home’ tab, click ‘Edit’ to control the PCA settings, and click ‘OK’.

a Click tab ‘Observations’ to check classes are selected; if not: select samples per class, name the new class and click ‘Set’.
b Click tab ‘Observations’ to exclude samples (e.g., QCs): select sample and click ‘Exclude’.

22 In the ‘Home’ tab, click ‘Autofit’ and ‘Scores’ to visualize model.
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Materials

Biological materials
● Stool samples: for development of the LA-REIMS procedures as well as to perform rapid fingerprinting
in a context of clinical diagnostics, stool samples were collected from study participants that
provided written, informed consent, following approval of the study by the ethics committee. For the
examples described in this protocol, samples were collected under University Hospital Ghent Ethical
Committee (EC 2016/0673). Collection of stool material is preferable performed by using specifically
designed equipment, such as Fecotainer or FecesCatcher (De Fecesvanger, The Netherlands;
both of these products provide detailed instructions). Other tools (e.g., plastic bag, plastic disposable,
bucket) are also suitable although considered less convenient for the study participant. Upon
collection, fresh stool samples should immediately be frozen at −80 °C if possible—for example, if
sample collection takes place at a hospital or research facility. If the sample is collected at the
participant’s home, temporary storage at −20 °C will be needed, but should be kept as short as
possible. Transport of the sample to the relevant facilities should be realized under cooled conditions
(0 °C or lower; using ice packs, dry ice or liquid nitrogen). Prior to storage at −80 °C, lyophilization is
advised to remove water and stop microbial activity. In this study, lyophilization was achieved by
placing the samples in a Christ 1-4 Alpha LSCplus lyophilizator for 48 ± 4 h at −40 °C. Lyophilized
samples were ground with pestle and mortar and sieved (mesh size of 2.5 mm) to obtain a
homogeneous powder.

To demonstrate the application potential of LA-REIMS stool fingerprinting in a clinical context,
stool material was collected from male and female study participants with normal blood glucose levels
and those that were diagnosed with type 2 diabetes, thereby applying a classification threshold of
60 mmol/mol glycated hemoglobin (HbA1c) c CRITICAL It is important that stool material not be
contaminated with urine during its collection c CRITICAL Fresh (nonlyophilized) samples should be
kept frozen at all times to avoid metabolic alterations.

● Blood samples (plasma): for development of the LA-REIMS procedures as well as to perform rapid
fingerprinting in a context of clinical diagnostics, blood samples were collected from study participants
that provided written, informed consent, following approval of the study by the ethics committee. For
the examples described in this protocol, samples were collected under University Hospital Ghent
Ethical Committee (EC 2016/0673).
Blood samples were collected from the study participants using a 10 mL syringe and transferred

into a heparin-containing tube, which was centrifuged for 10 min at 2,800–3,000g (at 2–8 °C). The
obtained plasma was transferred to a cryovial and stored at −80 °C. If needed, transport of the plasma
samples should be realized under cooled conditions (0 °C or lower; using ice packs, dry ice or liquid
nitrogen) c CRITICAL Samples should be kept frozen at all times to avoid metabolic alterations.
Thawing of the material for LA-REIMS analysis should be performed at 4–6 °C c CRITICAL Upon
long-term storage (>1 year), protein precipitation may occur, for which additional purification measures
should be taken prior to LA-REIMS analysis.
● Saliva samples: for development of the LA-REIMS procedures as well as to perform rapid
fingerprinting in a context of clinical diagnostics, saliva samples were collected from study participants
that provided written, informed consent (or parents in the case of minors), following approval of the
study by the ethics committee. For the examples described in this protocol, samples were collected
under University Hospital Ghent Ethical Committee (EC 2016/0673).
Collection of saliva should be established under standardized protocols to minimize the impact of

confounding factors, e.g., brushing of teeth, time slot of sample collection, and dietary restrictions
with respect to food and drinks consumption prior to sample collection. Collection of saliva can be
achieved by passive drooling or usage of suitable swabs such as Salivette synthetic (Sarstedt) or
SalivaBio (SalivaBio) swabs. After collecting the saliva material in a cryovial, snap-freezing and/or
storage at −80 °C is designated. Given the nature of the sample collection, it is possible and advised to
collect samples at equipped facilities where these protocols can be applied to minimize metabolic
alterations that may occur during, e.g., sample transport.

To demonstrate the application potential of LA-REIMS saliva fingerprinting in a clinical context,
saliva material was collected from children and adolescents (6–16 years), which were classified
according to weight status, using the International Obesity Task Force (IOTF) score (z-score for BMI)
(IOTF of 0 for normal weight, 1 for overweight and 2 for obesity) c CRITICAL Fresh samples should
be kept frozen at all times to avoid metabolic alterations. Thawing of the material for LA-REIMS
analysis should be performed at 4–6 °C.
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● Urine samples: for development of the LA-REIMS procedures as well as to perform rapid fingerprinting
in a context of clinical diagnostics, urine samples were collected from study participants that provided
written, informed consent (or parents in the case of minors), following approval of the study by the
ethics committee. For the examples described in this protocol, samples were collected under University
Hospital Ghent Ethical Committee (EC 2017/1634).
Urine samples can be collected in a plastic 100 mL container in the case of adults or children

that are neat, whereas alternative tools need to be used if children are not neat; e.g., Sterisets
Newcastle Urine Collection Packs (Sterisets Medical Devices). With respect to the latter, urine
can be extracted from these packs using a syringe. Samples should be stored as soon as possible
at −20 °C (at the participant’s home) or −80 °C (at equipped facilities). If transport is needed,
this should be realized under cooled conditions (0 °C or lower; using ice packs, dry ice
or liquid nitrogen) c CRITICAL It is important that urine not be contaminated with stool material
when collecting from children who are not neat c CRITICAL Samples should be kept frozen at
all times to avoid metabolic alterations. Thawing of the material for LA-REIMS analysis should be
performed at 4–6 °C.

Sputum: for development of the LA-REIMS procedures, sputum samples were obtained
from the Royal Brompton Hospital as part of routine sample collection for monitoring of
cystic fibrosis patients. Sputum can be collected as either spontaneous or induced dependent
on clinical guidelines and practice in sterile universal containers. Samples can be treated with Sputasol
to allow easier handling or analyzed neat. They can further be analyzed immediately upon
sampling or stored at –80 °C c CRITICAL Samples should be kept frozen at all times to avoid
metabolic alterations. Thawing of the material for LA-REIMS analysis should be performed at 4–6 °C.
! CAUTION For safety purposes, samples should not be collected from patients with positive results or
suspected symptoms of tuberculosis, unless samples can be stored, processed and analyzed in category
III biohazard facilities. If samples contain blood, they should not be analyzed and should be disposed
of immediately.
● Human milk: for development of LA-REIMS procedures, human milk samples were collected from a
cohort of breastfeeding dyads with nursling ages ranging between 3 and 24 months. For this purpose,
samples were collected under a subproject (approval number R18006) of the Breastmilk Epigenetic
Cohort Study under the Imperial College Healthcare Tissue Bank (HTA licence 12275), which received
ethical approval from the Wales Regional Ethics Committee (reference 17/WA/0161). Participants
should be free to choose method of expression (hand, electric or manual pump), but sterility of
collection equipment (pump, tubing, containers) should be achieved through steam sterilization
following manufacturers’ procedures. Samples should be collected into sterile containers suited to the
volume of collected human milk sample. Samples can be analyzed immediately (within 60 min of
collection) or stored at −20 °C or −80 °C depending on availability of facilities c CRITICAL Samples
should be kept frozen at all times to avoid metabolic alterations. Thawing of the material for
LA-REIMS analysis should be performed at 4–6 °C.

Reagents
● Isopropylalcohol (LC-MS grade, Sigma Aldrich, cat. no. 34863)
● Ultrapure water (0.055 μS/cm, purchased or obtained from water-purification systems such as
Sartorius Arium 661 UV, Sartorius)

● Sodium formate calibration solution (see ‘Reagent setup’)
● 0.5 mM sodium hydroxide in 90:10 isopropylalcohol /water (vol/vol) (Waters, cat. no. 186007052)
● Formic acid >99.0%, LC-MS grade (Thermo Fisher Scientific, Sigma Aldrich, cat. no. 117-50)
● Methanol, LC-MS grade (Sigma Aldrich, cat. no. 646377)

External standards (can be added to the isopropylalcohol solvent matrix)
Depending on the experimental setup, one or multiple compounds may be co-infused with the
isopropylalcohol solvent matrix during analysis. Details on how to prepare the solutions are in
‘Reagent setup’.
● (Optional) Leucine-enkephalin (Waters, cat. no. 186006013)
● (Optional) Palmitic acid-d31 (Sigma Aldrich, cat. no. 366897)
● (Optional) 1,2-dimyristoyl-d54-sn-glycero-3-phosphocholine (Sigma Aldrich, cat. no. 711047)
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Equipment
Personalized protective equipment
● Nitril gloves (EcoSHIELD Eco NitrilePF 250, NOVOLAB NV)
● Laser safety glasses LG16 4.00, 41% Visible Light Transmi Commodity: 9004 9010, RoHS:
A (compliant 2011/65/EU) (Thorlabs)

General laboratory equipment
● WipeAway wipes
● Micropipettes, 100–1,000 µL (Eppendorf, cat. no. 4924000088)
● Volumetric beakers, borosilicate glass 3.3, 100, 250, 600, 1,000 mL (VWR, cat. nos. 470328-028,
470328-032, 470328-040)

● Cotton cleaning swabs (Biolab, cat. no. CTA90003)
● Microscope blank glass slides (Marienfeld, cat. no. 1000000)
● Microtiter plates (NOVOLAB NV, cat. no. 32004)
● Elmasonic P ultrasonic bath (Elma, cat. no. 101 3737)

Laser setup
● Opolette HE2940 pump laser (OPOTEK) consisting of an Nd:YAG laser, steering optics, OPO (fixed at
2,940 nm), wavelength separation optics and laser power supply

● Power meter (Quantel, cat. no. 17509030)
● Aluminum breadboard 200 × 200 × 12.7 mm and M6 taps (Thorlabs, cat. no. MB2020/M)
● Fee space optics, enfolding a line of metallic or gold-coated mirrors (OptoSigma Global Top, cat.
no. W3031)

● Fixed lens holders LHG RoHS W4148 (Sigma-koki, Japan, cat. no. W4148), kinematic mirror holders
RoHS W4002 (Sigma-koki, cat. no. W4002)

● Pedestal bases (45.8 mm) onto which lenses and mirrors are mounted using pedestal clamps RoHS
W6039 (Sigma-koki, cat. no. W6039)

● Clamps and damped rods for every mirror and/or lens, using a 65 × 65 mm M6 plateau (Sigma-koki,
cat. no. W6051)

● Z axis aluminum translation stages (65 × 65 mm) (Sigma-koki, cat. no. W7514)
● CAF2 plano-convex lens RoHS W3189 (Thorlabs, cat. no. W3189)
● PEEK tubing, 0.010 in. ID; 30 cm (Thermo Fisher Scientific, cat. no. 10574855)
● Cytiva PEEK Connectors 1/16 in. Luer (Thermo Fisher Scientific, cat. no. 11370232)

REIMS
● Polytetrafluorethylene tubing (2.5 m, 3.2 mm outer diameter (OD), 1.6 mm inner diameter (ID), Sigma
Aldrich, cat. no. 58699) connected to the REIMS interface by means of a T-shaped connector piece
(prototype, Waters Research Center)

● REIMS source (prototype, Waters Research Center) with a 20 cm inlet capillary of 0.7 mm ID mounted
onto the housing of the T-shaped connector piece by a length of 0.1 mm ID PEEK tubing to a 10 mL
glass syringe

● 10 mL glass syringe (Hamilton, cat. no. 81620)
● Harvard 11 Elite syringe pump (Harvard Apparatus, cat. no. 70-4504) for isopropylalcohol infusion
(enclosing external calibration/lock mass compound)

● Computer (64-bit operating system, 4 GB random-access memory, Windows 10, Lenovo)
● Xevo G2-XS quadrupole time-of-flight mass spectrometer (QToF-MS; Waters)

Software
● MassLynx (v4.2, Waters)
● Progenesis Bridge (v1.0.29, Waters)
● Progenesis QI (v2.1, Waters)
● SIMCA (v15, Sartorius)

Reagent setup
Preparation of sodium formate calibration solution
1 Prepare 1 mL of 10% formic acid/aqueous solution by mixing 900 μL of ultrapure water and 100 μL

LC-MS grade formic acid; sonicate for 5 min (40 kHz, fixed frequency, no heating).
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2 Mix 100 μL of 10% formic acid/aqueous solution to 30 mL of 0.5 mM sodium hydroxide in 90:10
isopropylalcohol/water (vol/vol), and transfer to an amber glass vial; sonicate for 5 min (40 kHz,
fixed frequency, no heating).

j PAUSE POINT The sodium formate solution can be stored at 4 °C for up to 3 months.

(Optional) Leucine-enkephalin in isopropylalcohol
Can be used as an external standard for analysis in both positive and negative ionization mode6.
1 Add 7.5 mL of ultrapure water to a 3 mg bottle of leucine-enkephalin.
2 Recap, vortex for 30 s at 14g and sonicate for 5 min; the resulting 400 ng/μL solution can be stored

at −20 °C for up to 3 months.
3 Transfer 5 μL of 400 ng/μL leucine-enkephalin solution to a 50 mL glass vial, and add 20 mL of

isopropylalcohol to obtain a 0.1 ng/μL stock solution. Sonicate for 5 min (40 kHz, fixed frequency,
no heating). Label and store at −20 °C for up to 1 month.

4 Transfer 1 mL of 0.1 ng/μL leucine-enkephalin solution to 9 mL of isopropylalcohol stored in an amber
glass vial to obtain a 10 ng/mL solution; sonicate for 5 min (40 kHz, fixed frequency, no heating).

j PAUSE POINT The resulting solution can be used directly in the experiment or stored at −20 °C
for up to 1 week.

(Optional) Palmitic acid-d31 in isopropylalcohol
Can be used as external standard for negative ionization only. If the experiment involves alternating between
positive and negative ionization mode during LA-REIMS analysis, it is possible to add 1,2-dimyristoyl-d54-
sn-glycero-3-phosphocholine to this solution as an external standard for positive ionization12.
1 Weigh 1 mg of palmitic acid-d31 into a 5 mL glass vial.
2 Add 1 mL of ultrapure water, vortex for 30 s at 14g and sonicate for 5 min (40 kHz, fixed frequency,

no heating); the resulting 1 mg/mL stock solution can be stored at −20 °C up to 3 months.
3 Transfer 50 μL of 1 mg/mL stock solution into a 10 mL glass bottle, and add 9.95 mL of

isopropylalcohol; sonicate for 5 min (40 kHz, fixed frequency, no heating).

j PAUSE POINT The resulting 5 ng/μL solution can be used for sample analysis or stored at −20 °C
for up to 1 month.

(Optional) 1,2-dimyristoyl-d54-sn-glycero-3-phosphocholine in isopropyl alcohol
Can be used as external standard for positive ionization only. If the experiment involves alternating
between positive and negative ionization mode during LA-REIMS analysis, it is possible to add
palmitic acid-d31 to this solution to also cover negative ionization12.
1 Weigh 10 mg of 1,2-dimyristoyl-d54-sn-glycero-3-phosphocholine in a 10 mL glass vial.
2 Add 10 mL of methanol, vortex for 30 s at 14g and sonicate for 5 min (40 kHz, fixed frequency, no

heating); the resulting 1 mg/mL stock solution can be stored at −20 °C up to 3 months.
3 Transfer 100 μL of 1 mg/mL stock solution into a 10 mL glass bottle, and add 9.9 mL of

isopropylalcohol; sonicate for 5 min (40 kHz, fixed frequency, no heating).

j PAUSE POINT The resulting 100 ng/μL solution can be used for sample analysis or stored at
−20 °C for up to 1 month.

Equipment setup
MS parameters
Use the following general settings for the Waters Xevo G2-XS QToF instrument.

Instrument parameters

Mass range, Da 50–1,200

Analyzer mode Sensitivity

Data format Continuum

Acquisition start time, min 0

Acquisition end time, min 0.5 (manual sampling); 0.3 (automated sampling)

Target enhancement Off

Use the following optimized setup parameters for the Waters Xevo G2-XS QToF instrument
combined with MID-IR laser (Q-switch delay time) or CO2 laser (laser power and pulse values) for
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the specified biofluids in positive (+) and negative (−) ion polarity modes. Abbreviations used: NA,
not applicable.

Urine Feces Saliva Plasma Sputum Human Milk

Polarity +/− +/− +/− +/− +/− +/−

Solvent flow rate, mL/min 0.30 0.15 0.12/0.20 0.30/0.20 0.25 0.25

Cone voltage, V 25 40/70 20/45 30 80 80

Heater bias voltage, V 25 40 75/70 40 50 50

Laser wave-length, µm 2.94 2.94 2.94 2.94 10.64 10.64

Laser Q-switch delay time, µs 185 180 165/180 170/165 NA NA

Laser power, W NA NA NA NA 2.0 3.5

Pulse time, ms NA NA NA NA 40 40

Scan time, s 0.7/0.5 0.3 0.5 0.7 1.0 1.0

Procedure

Setup of the sample holder or container ● Timing 1–2 min per sample
1 Transfer the samples to an appropriate sample holder or container. Sample handling will be

different depending on the adopted sampling approach (manual or automated) as well as on the
sample matrix (liquid or semi-fluid). For manual sampling of liquids and semi-fluids (A and B),
multiple sample slides can be prepared in advance, but preferably not more than ten samples at a
time, as the thin sample layer will dry out within 20–30 min under ambient conditions. For
automated sampling, the position of the samples within the 96-well plate corresponds to the order
within the acquisition sequence (C and D). If more than one well plate is to be analyzed, it is
recommended to cover the well plates with a self-adhesive polyester foil to reduce sample
evaporation pending analysis.
(A) Manual sampling of liquids. Using a 100 μL pipet, transfer 20–50 μL of liquid sample

(e.g., plasma, urine, saliva, human milk, sputum treated with Sputasol) to the glass microscope
slide. Use separate slides for each sample.

(B) Manual sampling of semi-fluids. Using a disposable sterile spatula, apply a thin layer
(~50–80 mg) of semi-fluid sample (e.g., feces, untreated sputum) to the microscope slide, and
distribute evenly.

(C) Automated sampling of liquids. Using a 100 μL pipet, transfer 100 μL of liquid sample (e.g.,
plasma, urine, saliva, human milk, sputum treated with Sputasol) to its designated well within
a 96-well plate.

(D) Automated sampling of semi-fluids. Using a disposable sterile spatula, fill the sample well with
semi-fluid sample (e.g., feces, untreated sputum) to approximately half of the well’s height
(80–100 mg of sample generally suffices).

Setup of the laser ● Timing 10–15 min
2 The authors of this protocol had access to an Nd:YAG MIR OPO laser and CO2 laser for their

experiments. Both lasers have been demonstrated suitable to achieve ablation of liquid and semi-
fluid biological material. Preparation of the lasers for sample ablation is detailed below in options A
and B, respectively.
(A) MIR OPO laser

(i) On the front panel of the laser pump power supply, turn the safety key to the ‘On’ position
(45° clockwise).

(ii) The LED indicators within the water reservoir level window will light up; ensure that the
water level is above the window minimum indication.

(iii) In the system menu of the laser control panel, choose ‘system settings’ and check the
coolant temperature readback. Wait ~5–10 min until the coolant temperature rises up to
37.5 °C.

(iv) In the Q-switch configuration menu of the laser control panel, set the Q-switch delay time
to the optimized value for the selected matrix (‘Equipment setup’).
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(v) In the Q-switch configuration menu, set the Q-switch repetition rate to F/01 (20 Hz). This
value is standard for all described methods independent of the matrix.

(B) CO2 laser
(i) Ensure that the laser hollow-core fiber is connected correctly to both the laser unit and the

focusing system and that there is no visible damage to the fiber or connecting points.
(ii) Turn on the front panel of the laser, and ensure that any connecting gas supplies for

cooling are turned on to the correct pressure setting.
(iii) The laser will run through a self-check procedure to ensure it is operating at the

appropriate level. Any errors will be communicated on the display screen for user
troubleshooting.

(iv) With the laser on ‘Standby’ mode, adjust the laser operating settings to the required
pulsatile mode, pulsatile duration, output power and gas flow pressure.

(v) On the display screen, switch the laser to ‘On’mode, and wait 10 s to ensure that no system
error messages appear.

Connecting REIMS sampling tube, solvent line and MS source ● Timing 5–10 min
3 Fix one end of the polytetrafluoroethylene (PTFE) transfer tube 1 cm above and 3–4 mm to the side

of the laser focus point on the sampling surface (to check the position of the laser focus point,
follow step 2 as described in Box 2).

4 Using PEEK fitting (¼-28 flangeless nuts for 1/8″ OD tubing), connect the other end of the PTFE
transfer tube to the T-piece placed at the end of the ion transfer capillary in the REIMS source (Fig. 4b).

5 Fill the 10 mL glass Luer-lock syringe with isopropylalcohol (for isopropylalcohol containing
reference external standards, see ‘Reagent setup’).

6 Use Cytiva Luer PEEK Connectors to connect the syringe to the PEEK tubing; use two-piece PEEK
fittings with ferrules to connect the solvent live with the T-piece at the level of the MS source (Fig. 4b).

System preparation and optimization ● Timing 20–25 min
7 On the front panel of the solvent pump, set the solvent flow rate according to the optimized method

parameters per sample matrix and chosen polarity (‘Equipment setup’), and turn on the flow by
pressing the ‘Run’ button.

8 Observe the MS signal from the solvent flow on the MassLynx tune page. Record the blank solvent
signal and compare the spectrum profile with the blank solvent signal from a previous experiment.
? TROUBLESHOOTING

9 (Optional) If using external standards within the isopropylalcohol solution, check if the m/z peaks of
these external standards are clearly visible within the solvent spectrum on the MassLynx tune page.

10 Follow the procedure described in ‘Sample analysis’ (Step 30A and B), analyze ten eQC samples,
respectively, in negative and positive ion mode. This additional measure will ensure conditioning of
the instrument with the matrix-specific ions and reduce MS signal variation over time during
subsequent analysis of biological samples.

External calibration of the REIMS ● Timing 40 min

c CRITICAL STEP The instrument should be calibrated daily to ensure high mass accuracy.
11 Fill the glass syringe (10 mL Fixed Luer Lock Tip Syringe, SGE, cat. no. 008970) with 0.5 mM

sodium formate calibration solution.
12 Initiate MS scanning by pressing the ‘On’ (‘I’) button on the MassLynx tune page.
13 On the front panel of the solvent pump, set up the solvent flow rate at 0.2 mL/min and initiate the

flow by pressing the ‘Run’ button.
14 Wait until the sodium formate spectrum is visible and stable on the MassLynx tune page (multiple

high peaks distributed across entire m/z range).
15 Select the ‘MS console’ tab in the MassLynx tune page and subsequently the ‘IntelliStart’ tab. Set the

system to ‘Configuration mode’ by choosing it in the ‘Configure’ drop-down menu at the top of
the page.

16 Tick the empty box next to the ‘Create Calibration’ option on the instrument configuration panel,
and press ‘Start’.

17 The step-by-step create calibration wizard algorithm will appear on the screen. Press ‘Create Profile
Editor…’, then select ‘File’ drop-down from the pop-up window and press ‘New’ to define a new
calibration profile.
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18 Populate the ‘New calibration profile window’ by defining the profile name, setting the mass range
from 50 to 1,200 Da and the calibration type as ‘Assisted’.

19 In the calibration profile window click ‘Edit…’ next to the ‘Positive polarity’ section. In the new
window, choose ‘Enabled’ as an option for calibration reference compound, and select sodium
formate in the drop-down menu.

20 Repeat Step 15 for the ‘Negative polarity’ section within the calibration profile window.

j PAUSE POINT Once created, the calibration profile can be updated each time a new instrument
calibration is performed by resetting the already calibrated profile through the ‘Edit’ drop-down
menu in the Calibration profile editor. The reset profile will save all defined calibration settings but
lacks calibration data, so it can be used for new calibration (the ‘green tick’ next to the calibration
profile will change to ‘orange triangle’ in the Calibration Profile pull-down menu).

21 Choose both sensitivity and resolution mode for positive and negative polarity calibration by
ticking the corresponding boxes in the Calibration setup wizard page.

22 Check both boxes (‘Display Report’ and ‘Make Calibration Profile Active’) in the ‘Options’ section.
23 Do not change any settings on the other pages of the Create Calibration wizard sequence, and click

the ‘Next’ button on the bottom of every page to reach the end of the sequence.
24 Press the ‘Start’ button at the end of the Create Calibration wizard sequence. The calibration

process will be initiated by the software.
25 At the end of the calibration process, the Calibration report for evaluation pops up. All peaks in the

acquired datafile should be matched with the reference file for sodium formate (100% peaks detected),
the root mean square residual mass and 95% confidence band should be below 5 ppm mass deviation.

26 If the abovementioned criteria for good system calibration are met, accept the calibration report by
clicking on the green ‘tick’ symbol above on the Calibration report page. Continue the evaluation
for both modes (sensitivity and resolution) and both polarities (negative and positive).

27 When calibration has been successfully finalized, a new calibration file will be automatically saved
and uploaded on the MS control panel.

28 Remove the remaining calibration solution from the syringe and replace the solvent to
isopropylalcohol, start the solvent pump and initiate the MS acquisition. Flush ~20 min to remove
the remaining calibration solution from the system.

29 After ~20 min, check the tune page MS spectrum; no additional peaks aside from the
isopropylalcohol ions should be present within the spectrum TIC.

Sample analysis
30 Depending on whether a manual or automated sampling analysis will be performed, follow the

steps in options A or B.
(A) Manual analysis ● Timing 30 s/sample (per ionization mode)

(i) In the MassLynx software window, initiate MS acquisition by selecting all samples in the
sample sequence that should be analyzed within one batch, and press the ‘Run sequence’
button at the top of the page.

(ii) Activate the laser by pressing the ‘Start’ button next to the flash lamp and Q-switch
indicators on the laser control panel.

(iii) Place the microscope slide, carrying the sample, under the laser focus point for ablation;
remove after 3 s.

(iv) (Optional) Repeat step (iii) to generate several replicates. If you do this, record 3–4 s (blank
background signal) between burns for optimal peak resolution.

(v) Repeat steps (i)–(iv) for any other sample to be analyzed.

c CRITICAL STEP Routinely clean the laser focusing lens from the side of ablation with a
cotton bud dipped in ethanol every five to ten burns depending on the normal rate of
contamination. Clean the focusing lens in a similar fashion whenever the intensity of
acquired spectra decreases >10%.

(vi) (Optional) Repeat steps (i)–(v) for all samples when analyzing the samples in the opposite
polarity mode, changing to the appropriate experimental settings (‘Equipment setup’).

(B) Automated analysis ● Timing 23 s/sample (per ionization mode)
(i) Position the microtiter plate(s), containing the samples, on the sampling surface.
(ii) Ensure that the laser focus point lies in the middle of the first well (check with the

alignment diode beam; see steps 1–8 for external optics alignment verification as described
in Box 2).
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(iii) Within the laser controlling software, the following experimental sequence should be
programmed: a 3 s burn followed be a 20.6 s cooldown period.

(iv) Within the stage controlling software, define the number of sample-filled wells to be
analyzed (i.e., the number of repetitive movements that the stage has to perform to position
every sample-filled well under the laser focus point). The moving stage ‘move and wait’
cycle timing should correspond to the laser sequence program cycle of 23.6 s).

(v) Initiate the autosampler robot sequence.
(vi) After 5 s, initiate the MS instrument acquisition sequence. This will set the burn ‘retention

time’ at ~15 s in the acquisition file.

c CRITICAL STEP Clean the laser focusing lens from the side of ablation with a cotton bud
dipped in ethanol every 10–15 burns.

(vii) (Optional) Repeat steps (iv)–(vii) for all samples when analyzing the samples in the
opposite polarity mode, changing to appropriate experimental settings (‘Equipment setup’).

Computational analysis ● Timing 1 h/500 samples
31 Load the acquired spectra into the appropriate software.

c CRITICAL STEP Data collected on the LA-REIMS instrument (Waters) are processed sequentially
by Progenesis Bridge (v1.0.29, Waters) and Progenesis QI (V2.1, Waters); see steps 1–11 in Box 3.

32 Apply preprocessing to the spectra, including noise removal, baseline subtraction, selecting burns
and peak picking.

33 Load the peak lists (m/z features) into the appropriate software.

c CRITICAL STEP The choice of software will depend on the classification modeling approach
selected (commercial, open-source software) and compatibility with the output format after
preprocessing. Here, data collected from Progenesis QI (v2.1, Waters) are loaded into SIMCA (v15,
Sartorius); see steps 12–22 in Box 3.

34 Select features that show statistical and significant differences in the discriminative analysis.

Table 1 | Cleaning and maintenance

Component Method Frequency Considerations

Beam
transmission
(mirror or fiber)

Clean the mirror with manufacturer-recommended
solvent and the fibers by flushing with nitrogen
or helium

As necessary based on laser
power output monitoring

Replacement of fiber should be in line
with manufacturer recommendations
or as necessary based on laser power
output monitoring

Beam
focusing lens

Clean with manufacturer-recommended solvent,
absorbed into nonscratch material swab/tissue

Daily or as necessary based
on laser power output
monitoring

Analysis of samples such as feces may
result in debris build-up on lens and
requires more frequent cleaning

Aerosol
transfer line

It is difficult to remove solvent from the line, so if it is
dirty, the dirty section should be removed. First trim 2
cm from the ends, and if this does not improve things,
replace the PTFE tubing in its entirety

Trimming of 2 cm from the
ends is recommended daily,
with replacement of entire
length weekly

T-piece and inlet
capillary

Dismantle the setup and sonicate (40 kHz, ‘Sweep’
mode/alterating frequency, no heating) in
isopropylalcohol/water (50:50 vol/vol) for 10 min
followed by air drying for 30 min

Daily Cleaning solvent may be altered to
remove particular chemical
contamination (e.g., MS Cleaning
Solution (Waters, cat. no. 186006846)
or appropriate mild soap solution for
precipitated proteins)

REIMS interface Dismantle the interface, and swab the exposed parts
using methanol using nonscratch material swab/tissue
followed by air drying for 30 min

Weekly or as necessary if
contamination is detected in
background signal

If venting of the instrument and
recalibration is required, this should be
accommodated in the analytical
schedule

Ion guide (e.g.,
Waters
StepWave)

Rremove the ion guide from the instrument housing,
and clean using manufacturer recommended routine.
Typically, 30 min sonication (40 kHz, ‘Sweep’ mode/
alterating frequency, no heating) in MS Cleaning
Solution (Waters, cat. no. 186006846), 10 min
sonication in methanol:water (50:50 vol/vol) followed
by 10 min sonication in methanol and air drying
for 30 min

Weekly or as necessary if
contamination is detected in
background signal

As venting is required, clean the ion
guide at the same time that you clean
the REIMS interface
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Cleaning and maintenance procedures ● Timing 1.5 h
35 After the experiment, and as part of troubleshooting, you will need to clean and maintain the

instruments. Follow the guidelines in Table 1 for maintenance methods and frequency rate for each
hardware component of the LA-REIMS setup.

Troubleshooting

Troubleshooting advice can be found in Table 2.

Timing

Step 1, setup of the sample holder or recipient: 1–2 min/sample
Step 2, setup of the laser: 10–15 min
Steps 3–6, connecting REIMS sampling tube, solvent line and MS source: 5–10 min
Steps 7–10, system preparation and optimization: 20–25 min
Steps 11–29, external calibration of the REIMS interface: 40 min
Step 30A, manual analysis: 30 s/sample
Step 30B, automated analysis: 23 s/sample
Steps 31–34, computational analysis: 1 h/500 samples
Step 35, cleaning and maintenance: 1.5 h
Box 1, sample preparation: 0–15 min/sample
Box 2, laser alignment verification: 20–30 min
Box 3, LA-REIMS data analysis and classification modeling: 1 h/500 samples

Table 2 | Troubleshooting table

Step Problem Possible reason Solution

8 While infusing pure
isopropylalcohol, the tune
page spectrum displays
additional m/z signals

Source, solvent line or sample tube
may be contaminated

Perform additional cleaning and/or
change infusion solvent

Box 2, step 5 While aligning the laser beam,
the green light is not visible
within the alignment target

Laser energy output is not sufficient
to activate fluorescent
photosensitive matrix on alignment
target surface

Decrease the laser Q-switch delay to
300 µs

Box 3, step 1c The number of bridged files is
different than the number
of burns

When fewer bridged files than
burns are observed, the TIC
threshold may be set too high (only
highest peaks are recognized). If
only one bridged file is produced
after processing, this might imply
that the TIC threshold is either too
low and all signals above the
threshold are combined in one peak
or too high and only the highest
peak is detected. In the latter case,
often samples for which none of the
peaks meets this high threshold
value will be absent from the
‘processed’ directory

Check peak and background
intensities in 10% of samples. Make
sure to include runs at the end of the
experiment as intensities might be
somewhat lower. If possible, choose
one threshold value for processing of
all experimental files within one
polarity mode. If the differences in
intensities within the experiment are
too large to correctly process all files
with one TIC threshold (may be
noticeable for 100 and more
samples), consider dividing files into
batches. Note: signal intensities differ
substantially between polarities
within one experiment. Therefore,
positive and negative data should be
processed separately with separate
TIC threshold values

Box 3, step 15c The errors ‘no valid values’,
‘missing observation ID’ or
‘missing variable ID’ pop up

No values are present in the dataset Check whether all ‘#DIV/0!’, ‘NA’,
‘∞’, … values are removed from the
dataset, including the header
information
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Anticipated results

In this protocol, we provide guidelines to perform rapid LA-REIMS metabolic fingerprinting of
various human biofluids, i.e., saliva, urine, plasma, stool, sputum and milk. Aspects on both sample
handling and instrumental setup are detailed. Using the outlined procedures, high-quality data for a
broad m/z spectrum (50–1,200 Da) can typically be acquired in <1 min per sample; including sample
loading and intersample equilibration. No substantial pretreatments of the biofluids are needed, with
the exception of saliva. As such, LA-REIMS offers relevant potential for diverse clinical applications,
in which rapid discriminative metabotyping and/or (point-of-care) personalized health care provision
are major objectives. In this section, we discuss the anticipated results as may be obtained upon
biofluid LA-REIMS analysis, with specific elaborations on the generated molecular fingerprints, the
precision of the analysis, and the application potential in a clinical context. For this, we chose
feces as a semi-fluid and saliva as a real biofluid, as examples for in-depth illustration of some
particular aspects.

Molecular fingerprints
For all biofluids and semi-fluids, the mass spectra that are generated by LA-REIMS comprise several
hundreds of features across the 50–1,200 Da m/z scan range, for both negative and positive ionization
mode. In Fig. 5, we show representative molecular fingerprints for saliva, plasma, urine, stool, milk
and sputum, as obtained from a single burn of a pooled sample (n = 10).

We did a similar experiment where we analyzed the samples by direct-infusion MS and have
included the methods and results for this in the Supplementary Discussion. From these results, it was
clear that we were able to get higher metabolome coverage using LA-REIMS. There was also sub-
stantial contamination at the ionization source for direct-infusion MS, making robust analysis of large
sample batches problematic. While these problems can be overcome using appropriate sample pre-
treatment for direct-infusion MS of biofluids (e.g., saliva, urine, blood) and even essential for semi-
fluids (e.g., feces), this requirement detracts from the pursuit of rapid (real-time) fingerprinting, as is
achieved by LA-REIMS.

For the various matrices, the total number of unique features that could be retrieved by con-
sidering the samples from ten individuals was 3,628 for saliva (52.0% of these were detected in
negative ionization mode), 3,015 for plasma (47.2% in negative), 3,767 for urine (54.1% in negative),
2,078 for feces (65.9% in negative), 3,065 for milk (31.6% in negative) and 2,039 for sputum
(35.1% in negative).

In-depth analysis of the metabolic fingerprints shows that the lower m/z region of 50–400 Da
generally contributes the most to the achieved metabolome coverage (number of detected features)
for negative ionization mode, but the m/z region of 200–600 Da contributes the most for positive
ionization mode (Fig. 6). This most likely relates to the specific metabolome composition of the
assessed matrices and the number of metabolite representatives for the various chemical classes (i.e.,
reflected by various functional groups and associated ionization behaviours). Also UHPLC-HRMS
analysis revealed specific m/z patterns, corresponding to the ionization mode, as illustrated for saliva
by Wijnant et al.12.

Taking into account the absolute metabolome coverage per matrix and making the comparison
between matrices, it may be noted that the metabolome of feces and milk contains a relatively low
proportion of high-weight features (>800 Da), whereas the sputum metabolome encompass a
relatively low proportion of low-weight features (<200 Da). It has indeed been described that sputum
especially contains a high fraction of various lipid species, including highly abundant sphingolipids
such as sphingomyelins, ceramides and lactosylceramides36. In human milk, a high abundance of
various low-to-medium-weight metabolites has been reported, such as oligosaccharides, amino acids
and derivatives, and fatty acids and associated metabolites37. For feces, the defined metabolome
composition may largely be determined by the metabolic activity of the gut microbial community,
including the metablization of large and complex structures38.

Fig. 5 | Typical mass spectra as obtained by LA-REIMS analysis of human biofluids. a–l, Acquired spectra for saliva
(a, positive ionization; b, negative ionization), plasma (c, positive; d, negative), urine (e, positive, f, negative), stool
(g, positive; h, negative), milk (i, positive; j, negative) and sputum (k, positive; l, negative), as obtained by a Waters
Xevo G2-XS qToF instrument. Figure adapted from refs. 11,12.
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The above-mentioned data were obtained for each biofluid on the basis of a single burn. A typical
burn for positive and negative ionization is shown in Fig. 3. Taking into account the scan time (see
‘Equipment setup’), the total number of scans acquired per burn varied between 4.2 scans (plasma)
and 10.0 scans (feces). A higher background level was generally obtained in positive ionization mode6

for all matrices, as displayed for feces (Fig. 3). It was verified that especially m/z features <350 Da
contributed to this background signal.

Precision
As a major parameter to assess performance quality, the precision of the LA-REIMS method was
verified for feces as a semi-fluid representative and saliva as a real biofluid. Repeatability was eval-
uated based on the repetitive (n = 3) laser ablation of a single sample as well as the sequential analysis
of ten different samples from the same sample pool. Reproducibility was assessed for three con-
secutive analysis days whereby ten sample aliquots were analyzed per day, prepared from the same
sample pool, stored at −80 °C and all subjected to one freeze–thaw cycle.

For the repeatability that was assessed by subjecting a single sample to three consecutive ablation
events, it was observed that the achieved metabolome coverage was highly repeatable across the
various burns, for both ionization modes and matrices (Table 3, minimum of 84.5% congruence).
With respect to the TIC, it was noted that considerable differences may occur from burn to burn
(Table 3, coefficient of variation (CV)% up to 45.5%). This is evidence that TIC-based data nor-
malization is essential to attain high-quality LA-REIMS metabolomics datasets. Indeed, by applying
TIC-based normalization, high signal repeatability was calculated, with ≥92.5% of the features found
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Fig. 6 | Typical m/z profiles as obtained by LA-REIMS analysis of human biofluids. a,b, Number of features that were measured per m/z class upon
LA-REIMS analysis of saliva, plasma, urine, feces, milk and sputum, in positive (a) and negative (b) ionization mode. For each matrix type, a single list
of m/z features was acquired, based on the processing of ten raw files (single burns), as obtained from ten different samples (i.e., individuals).

Table 3 | Evaluation of the short-term reproducibility, based on repetitive laser ablation (n = 3) of a single sample

Unique features within each burn (%) Average TIC ± CV%
across burns

Percentage of
features with CV% ≤ 30%

First burn Second burn Third burn

Feces

Positive ionization 9.4 4.1 6.1 7.8e6 ± 28.1 92.5

Negative ionization 3.7 0.4 4.3 3.8e7 ± 45.4 96.4

Merged polarities 5.4 1.6 4.8 95.5

Saliva

Positive ionization 2.6 1.7 1.5 3.6e7 ± 7.7 83.4

Negative ionization 0.5 0.2 1.3 1.9e7 ± 45.5 80.9

Merged polarities 1.5 0.9 1.4 82.0

CV, coefficient of variance; TIC, total ion current.
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in feces having a CV ≤ 30%39; the corresponding value for saliva was ≥80.9%. Based on the achieved
metabolome coverages that were highly similar across burns and the high signal repeatability upon
TIC-based normalization, acquisition of representative LA-REIMS metabolic fingerprints is possible
based on one burn only.

Evaluation of the intraday repeatability for the ten consecutive sample analyses was achieved by
assessing the similarity of the molecular profiles in terms of metabolome coverage and by calculating
the CV% for the TIC-normalized feature abundances. For feces and saliva, metabolome coverage was
considered highly repeatable in terms of number of features detected (Table 4). Moreover, the CV%
as determined for the TIC-normalized features’ abundances indicated that 71.8% of the fecal features
and 88.9% of the salivary features meet the 30% CV threshold, typically used in metabolomics
analysis39. Interday repeatability (i.e., the reproducibility) results were generally quite similar to those
obtained for the intraday repeatability assessment, indicating that high-quality data acquisition by
LA-REIMS can be actualized for both biofluid and semi-fluid analysis over the course of several days
(Table 4). Hereby, internal QC samples can be used as an efficient strategy to adjust for possible
instrumental variation (LOESS-based normalization).

It should be noted, however, that, for feces in positive ionization mode, only 38.9% of the detected
features had an acceptable CV ≤ 30%. This may partially relate to the fact that a higher noise level is
observed in positive ionization mode, which may somewhat hamper reproducible analysis.In addi-
tion, microbial enzymatic activity may reactivate after preparing the fecal slurry, as a result of which
the metabolic composition of the pooled sample may be altered.

Classification model
To demonstrate the application potential of LA-REIMS for rapid fingerprinting of bio/semi-fluids
and to substantiate the robustness of the methodology, this section describes two example clinical
cases: type 2 diabetes and overweight/obesity. For these cases, LA-REIMS discriminative finger-
printing according to health status was pursued by considering, respectively, a semi-fluid (feces) and
real biofluid (saliva).

Based on the fecal LA-REIMS fingerprints, a valid two-class OPLS-DA model was established to
discriminate between individuals with type 2 diabetes and those with normal glycemic state (i.e.,
euglycemia). Also, the PCA-X score plot (Fig. 7) showed some segregation of samples according to
health status. The OPLS-DA model (Fig. 7) was validated with a CV-ANOVA P-value of 1.93e−17,
valid permutation testing, and R2(X) of 0.230, R2(Y) of 0.946 and Q2(Y) of 0.734. Moreover, using a
fivefold 20% leave-out validation strategy, a general classification accuracy of 90.5% was calculated,
with a type 2 diabetes sensitivity of 89.5% and specificity of 91.7%. Initial classification of individuals
according to glycemic state was based on the glycated hemoglobin concentration (HbA1c), thereby
implementing a 60 mmol/mol threshold criterion. A total of 72 individuals took part in the study,
whereby 36 individuals had been assigned a state of type 2 diabetes and 36 individuals a state of

Table 4 | Evaluation of the short-term repeatability (ten samples, intraday) and long-term reproducibility (3 d, every day ten
samples)

Short-term repeatability (ten samples) Long-term reproducibility (3 d, ten samples per day)

Average number of
features ± CV%

Percentage of features
with CV ≤ 30%

Average number of
features ± CV%

Percentage of features
with CV ≤ 30%

Feces

Positive ionization 546 ± 3.8 67.9 528 ± 6.5 38.9

Negative ionization 1217 ± 3.0 73.5 1193 ± 3.8 70.3

Merged polarities 1765 ± 2.2 71.8 1721 ± 3.4 66.6

Saliva

Positive ionization 1079 ± 3.2 82.6 1090 ± 2.4 78.8

Negative ionization 1278 ± 0.5 94.3 1178 ± 0.4 88.7

Merged polarities 2357 ± 1.4 88.9 2284 ± 2.3 82.6
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euglycemia. A detailed explanation on the sample collection, data analysis, data processing and
interpretation of the results can be found in Van Meulebroek et al.11.

Whereas the main purpose of this experiment was the rapid discrimination and thus diagnosis of
glycemic state based on rapid LA-REIMS metabolic fingerprinting of the semi-fluid feces, the
instrumental platform also allows for some more in-depth interpretation of discriminative metabo-
lites (i.e., potential markers). To this end, samples can be subjected to MS/MS fragmentation, which
offers possibilities for tentative identification. In our study, this fragmentation strategy allowed us to
assign relevant metabolite identities, substantiating the method also suited for exploration of the
mechanisms involved in pathophysiology. Among others, 6-hydroxymelatonin, several nicotina-
mides, D-glucose, biotripyrrin and homocysteine-associated metabolites were tentatively identified as
metabolite markers40. As such, applying LA-REIMS fingerprinting, classification according to gly-
cemic state was considered possible based on validated supervised modeling, biological qualification
of tentatively identified metabolite markers, and supportive data from UHPLC-HRMS analysis11.

To assess overweight and obesity in young adolescents (6–16 years), saliva samples from 35
individuals with a healthy weight and 35 individuals with overweight/obesity were collected and
subjected to LA-REIMS analysis. Hereby, the primary purpose was to achieve discrimination
according to weight status, as this may enclose interesting opportunities to appoint metabolic per-
turbations according to pathophysiological state and evaluate, e.g., the contribution of etiological
factors and treatment efficacy. Initial adiposity classifications were based on BMI z-scores (adjusted
BMI for age and sex), following Roelants et al.41 and extended international (IOTF) BMI cutoffs for
thinness, overweight and obesity by Cole et al.42. A valid two-class OPLS-DA model (Fig. 7) could be
established, which allowed for discrimination between healthy weight (IOTF of 0) and overweight/
obesity (IOTF ≥ 1). Validation parameters comprised a CV-ANOVA P-value of 9.01 e−21, valid
permutation testing, and an R2(X) of 0.227, R2(Y) of 0.946 and Q2 of 0.808. In addition, based on a
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fivefold 20% leave-out validation strategy, a general classification accuracy of 97.1% was achieved,
with a sensitivity of 100% and specificity of 94.3%. A detailed explanation on the sample collection,
data analysis, data processing and interpretation of the results can be found in Wijnant et al.12.

Reporting Summary
Further information on research design is available in Nature Research Reporting Summary linked to
this article.

Data availability
Datasets relevant to our published supporting primary papers can be made available from the
corresponding author upon reasonable request. The source data for figures are publicly available in
the Figshare repository: Fig. 3, https://doi.org/10.6084/m9.figshare.14258423.v1; Fig. 5, https://doi.
org/10.6084/m9.figshare.14258438.v1; Fig. 6 https://doi.org/10.6084/m9.figshare.14258459.v2.
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samples was achieved by internal laboratory labeling. During data processing (i.e. supervised multivariate modelling), information about the 
health status was used. 

Reporting for specific materials, systems and methods
We require information from authors about some types of materials, experimental systems and methods used in many studies. Here, indicate whether each material, 
system or method listed is relevant to your study. If you are not sure if a list item applies to your research, read the appropriate section before selecting a response. 
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Methods
n/a Involved in the study

ChIP-seq

Flow cytometry

MRI-based neuroimaging

Human research participants
Policy information about studies involving human research participants

Population characteristics Population characteristics may be of importance when demonstrating the application potential of LA-REIMS for 
discriminative fingerprinting in a clinical context.  
1) Type 2 diabetes clinical case: adults (> 18 years) (type 2 diabetes: average 61 years +- 8; euglycemia: average 47 years +- 
9); BMI (type 2 diabetes: average 30.2 kg/m2 +- 3.8; euglycemia: average 23.6 kg/m2 +- 3.5); HbA1c (type 2 diabetes: average 
7.06% +- 0.9; euglycemia: average 5.53% +- 0.3); gender (men and women (type 2 diabetes: 25% women; euglycemia: 65.2% 
women). Within the group of type 2 diabetes patients; there was a high prevalence of metformin treatment.  
2) Overweight/obesity: adolescents (6 to 16 years) (healthy weight: average 14.2 years +- 1.7; overweight/obesity: average 
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13.7 years +- 2.6), gender (boys and girls; 42.9% boys for both healthy weight and overweight/obesity). 

Recruitment With respect to the type 2 diabetes study; patients were recruited at University Hospital Ghent. Hereby, both the attending 
physician as Ghent University scientist were present to inform the patient about the experimental set-up and input needed 
from the patient. All patients that met the inclusion critera were contacted, so self-selection bias was not present. For the 
healthy group, participants (i.e. those with a healthy glycemic state) were recruited amongst lab personnel and friends/family 
of lab personnel. All lab personnel was contacted, for which no selection bias is expected. 
With respect to the obesity/overweight study: participants were recruited from the Obesity Prevention through Emotion 
Regulation in Adolescents (OPERA) study and from the paediatric obesity department of the Jan Palfijn hospital. Inclusion 
criteria included no severe underweight (IOTF ≥ -1), no endocrine diseases. No selection bias was present. All participants 
were invited to the Ghent University Hospital Campus. To create uniformity, all participants were assigned to a single 
researcher, who was trained to guide the participants. Appointments were only made on school days, outside school hours 
(Monday - Tuesday - Thursday between 4.30 pm and 5.50 pm, Wednesday between 2 pm and 2.30 pm and between 4.30 pm 
and 5.50 pm). 

Ethics oversight University Hospital Ghent Ethical Committee; Wales Regional Ethics Committee 

Note that full information on the approval of the study protocol must also be provided in the manuscript.

Clinical data
Policy information about clinical studies
All manuscripts should comply with the ICMJE guidelines for publication of clinical research and a completed CONSORT checklist must be included with all submissions.

Clinical trial registration Not 

Study protocol Note where the full trial protocol can be accessed OR if not available, explain why.

Data collection Describe the settings and locales of data collection, noting the time periods of recruitment and data collection.

Outcomes Describe how you pre-defined primary and secondary outcome measures and how you assessed these measures.
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